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1.  Introduction 
 

1.1 Add-on Module STEEL AS 

The Australian Standard AS 4100 for Steel Structures describes the design, analysis, and con-
struction of steel structures. With the RSTAB add-on module STEEL AS the DLUBAL company 
provides a powerful tool to design steel structures according to the Australian code. 

STEEL AS performs all typical ultimate limit state designs as well as stability and deformation 
analyses. The program is able to take into account various actions for the ultimate limit state 
design. Furthermore, you can choose between the interaction formulae mentioned in the 
code. In accordance with the Australian code, STEEL AS divides the cross-sections to be de-
signed into the cross-section slenderness types. In this way, you can check the limitation of the 
design capacity and of the rotational capacity due to local buckling for cross-section parts. 
Moreover, STEEL AS determines the c/t-ratios of the cross-section elements subjected to com-
pression and classifies the cross-sections completely automatically. 

In STEEL AS, the indices of the member axes are different from those used in the code: The lon-
gitudinal axis is denoted by the index is x instead of z. For the axes in the cross-section plane, 
the axes y and z are used (see figure to the left). 

For the stability analysis, you can specify for each member or set of members whether flexural 
buckling occurs in y- and/or z-direction. Furthermore, you can define additional lateral sup-
ports in order to represent the model close to reality. STEEL AS determines the slendernesses 
and elastic critical buckling loads from the boundary conditions. The ideal critical moment for 
lateral torsional buckling required for the lateral torsional buckling design is determined auto-
matically. In addition to that, it is possible to take into account the load application point of 
transverse loads, which is affecting the torsional resistance considerably. 

For structures employing extremely slender cross-sections, the serviceability limit state repre-
sents an important design. The load cases, load and result combinations can be assigned to 
different design situations. The limit deformations are preset by default settings and can be 
adjusted, if necessary. In addition, it is possible to specify reference lengths and precambers 
that are considered accordingly in the design. 

If required, you can use the add-on module to optimise cross-sections and export the modified 
cross-sections to RSTAB. Design cases enable you to separately design structural components 
of complex models or to analyse variants. 

STEEL AS is an add-on module integrated in RSTAB. For this reason, the design relevant input 
data is already preset when you have started the module. Subsequent to the design, you can 
use the graphical RSTAB user interface to evaluate the results. Finally, the design process can 
be documented in the global printout report, from determination of internal forces to design. 

We hope you will enjoy working with STEEL AS. 

Your DLUBAL Team  
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1.2 STEEL AS - Team 
The following people were involved in the development of STEEL AS: 

Program coordination 
Dipl.-Ing. Georg Dlubal Dipl.-Ing. (FH) Younes El Frem 

Programming 
Ing. Zdeněk Kosáček 
Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Martin Budáč 

Mgr. Petr Oulehle 
Zbyněk Zámečník 
DiS. Jiří Šmerák 

Cross-section and material database 
Ing. Ph.D. Jan Rybín 
Mgr. Petr Oulehle 

Ing. Jiří Kubíček 

Program design, dialog figures, and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Ph.D. Martin Čudejko Dipl.-Ing. (FH) Wieland Götzler 

Localisation, manual 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Ing. Ph.D. Martin Čudejko 
Eng.º Rafael Duarte 
Ing. Jana Duníková 
Ing. Lara Freyer 
Alessandra Grosso 
Bc. Chelsea Jennings 
Jan Jeřábek 
Ing. Ladislav Kábrt 
Ing. Aleksandra Kociołek 

Ing. Roberto Lombino 
Eng.º Nilton Lopes 
Mgr. Ing. Hana Macková 
Ing. Téc. Ind. José Martínez 
MA SKT Anton Mitleider 
Dipl.-Ü. Gundel Pietzcker 
Mgr. Petra Pokorná 
Ing. Michaela Prokopová 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Marcin Wardyn 

Technical support and quality management 
M.Eng. Cosme Asseya 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. Moritz Bertram 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Bastian Kuhn 

Dipl.-Ing. (FH) Ulrich Lex 
Dipl.-Ing. (BA) Sandy Matula 
Dipl.-Ing. (FH) Alexander Meierhofer 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. The present manual focuses on typical fea-
tures of the add-on module STEEL AS. 

The descriptions in this manual follow the sequence of the module's input and results tables as 
well as their structure. The text of the manual shows the described buttons in square brackets, 
for example [View mode]. At the same time, they are pictured on the left. Expressions appear-
ing in dialog boxes, tables, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are looking 
for, please check our website www.dlubal.com where you can go through our FAQ pages by  
selecting particular criteria. 

1.4 Open the Add-on Module STEEL AS 
RSTAB provides the following options to start the add-on module STEEL AS. 

Menu 
To start the program in the RSTAB menu bar, click 

Add-on Modules → Design - Steel → STEEL AS. 

 

Figure 1.1: Menu: Add-on Modules → Design - Steel → STEEL  AS 

http://www.dlubal.com/
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Navigator 
As an alternative, you can start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL AS. 

 

Figure 1.2: Data navigator: Add-on Modules → STEEL  AS 

Panel 
In case results from STEEL AS are already available in the RSTAB model, you can also open the 
design module in the panel: 

Set the relevant STEEL AS design case in the load case list of the RSTAB toolbar. Use the button 
[Show Results] to display the design criterion on the members graphically. 

When the results display is activated, the panel is available, too. Now you can click [STEEL AS] 
in the panel to open the module. 

 

Figure 1.3: Panel button [STEEL AS] 
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2.  Input Data 
When you have started the add-on module, a new window opens. In this window, a Navigator 
is displayed on the left, managing the tables that can be currently selected. The drop-down list 
above the navigator contains the design cases (see chapter 7.1, page 52). 

The design relevant data is defined in several input tables. When you open STEEL AS for the 
first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations, and super combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a table, click the corresponding entry in the navigator. To set the previous or next in-
put table, use the buttons shown on the left. You can also use the function keys to select the 
next [F2] or previous [F3] table. 

Click [OK] to save the results. Thus you exit STEEL AS and return to the main program. If you 
click [Cancel], you exit the module but without saving the data. 

2.1 General Data 
In table 1.1 General Data, you select the members, sets of members, and actions that you want 
to design. The tabs are managing the load cases, load and result combinations as well as super 
combinations for the different designs. 

 
Figure 2.1: Table 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the input fields to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be selected by double-clicking and overwritten by entering the data manually. Click 
[] to select the objects graphically in the RSTAB work window. 

When you design a set of members, the program determines the extreme values of the de-
signs of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the result 
table 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts 
List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RSTAB 
appears where you can specify the parameters for a set of members. 
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2.1.1 Ultimate Limit State 

 
Figure 2.3: Table 1.1 General Data, tab Ultimate Limit State 

Existing Load Cases and Combinations 
In this column, all load cases, load combinations, result combinations, and super combinations 
created in RSTAB are listed.  

Click [] to transfer selected entries to the list Selected for Design on the right side. You can also 
double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries of load cases, click the entries while pressing the [Ctrl] key, as 
common for Windows applications. Thus, you can transfer several load cases at the same time. 

Load cases marked by an asterisk (*), like load case 9 in Figure 2.3, cannot be designed: This 
happens when the load cases are defined without any load data or the load cases contain only 
imperfections. When you try to transfer those load cases, a corresponding warning appears. 

At the end of the list, several filter options are available. They will help you assign the entries 
sorted according to load cases, load combinations, or action categories. The buttons have the 
following functions: 

 
Select all load cases in the list. 

 
Invert selection of load cases. 

Table 2.1: Buttons in the tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases as well as the load and result combinations select-
ed for design. To remove selected items from the list, click [] or double-click the entries. To 
transfer the entire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. However, the analysis of a result combina-
tion has also disadvantages: First, the influence of the contained loads is difficult to discern. 
Second, for the determination of the factor βm according to clause 4.4.2.2 (b), the envelope of 
the moment distributions is analyzed, from which the most unfavorable distribution (max or 
min) is taken. However, this distribution only rarely reflects the moment distribution in the  

 

Result  
combination 
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individual load combinations. Thus, in the case of a RC design, more unfavorable values for βm 
are likely that lead to higher ratios. 

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 

2.1.2 Serviceability 

 
Figure 2.4: Table 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases and Combinations 
In this column, all load cases, load and result combinations created in RSTAB are listed. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed, as de-
scribed in chapter 2.1.1. 

You can assign different limit values for deflection to the individual load cases, load combina-
tions, and result combinations. The following design situations can be selected: 

• Short term effects 

• Long term effects 

To modify the design situation, use the list which can be accessed at the end of the input field 
by clicking [] (see Figure 2.4). 

The limit values of the deformations are defined in the design details. To adjust these values 
according to the design situation, click [Details] to open the dialog box Details, tab Serviceability 
(see Figure 3.3, page 31). 

In the table 1.9 Serviceability Data, the reference lengths decisive for the deformation check are 
managed (see chapter 2.9, page 26). 
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2.2 Materials 
This table is subdivided into two parts. In the upper part, all materials created in RSTAB are 
listed. In the Material Properties section, the properties of the current material, that is, the table 
row currently selected in the upper section, are displayed. 

 
Figure 2.5: Table 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in chap-
ter 4.2 of the RSTAB manual (Main Properties). The material properties required for design are 
stored in the global material library. The values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu Settings → Units and Decimal Places (see chapter 7.3, page 56). 

Material Description 
The materials defined in RSTAB are already preset, but it is always possible to modify them: To 
select the field, click the material in column A. Then click [] or press function key [F7] to open 
the material list. 

 
Figure 2.6: List of materials 
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According to the design concept of the Australian Standard [1], you can select only materials 
of the “Steel” category. 

When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
STEEL AS will import the material properties, too. 

Principally, it is not possible to edit the material properties in the add-on module STEEL AS. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
click 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.7: Dialog box Material Library 

In the Filter section, Steel is preset as material category. Select the material quality that you 
want to use for the design in the list Material to Select. The corresponding properties can be 
checked in the dialog section below. 

Click [OK] or [↵] to transfer the selected material to table 1.2 of the add-on module STEEL AS. 
Please check, however, whether these materials are allowed by the design concept of the  
Australian Standard [1]. 

Chapter 4.2 in the RSTAB manual describes in detail how materials can be filtered, added, or 
rearranged. 
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2.3 Cross-sections 
This table manages the cross-sections used for design. In addition, the table allows you to 
specify optimisation parameters. 

 
Figure 2.8: Table 1.3 Cross-sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

If you want to modify a cross-section, click the entry in column B to select this field. Click 
[Cross-section Library] or [...] in the field or press function key [F7] to open the cross-section  
table of the current input field (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library] to access the gen-
eral cross-section library. 

Chapter 4.3 of the RSTAB manual describes how cross-sections can be selected from the library. 
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Figure 2.9: IS cross-sections in the cross-section library 

The new cross-section description can be entered in the input field directly. If the data base 
contains an entry, STEEL AS imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections set in STEEL AS are different from the ones used in RSTAB, both cross-sections 
are displayed in the graphic in the right part of the table. The designs will be performed with 
the internal forces from RSTAB for the cross-section selected in STEEL AS. 

Cross-Section Type for Classification 
The cross-section type used for the classification is displayed. The cross-sections listed in [1] 
table 5.2 can be designed plastically or elastically depending on the Class. Cross-sections that 
are not covered by this table are classified as General. 

Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
sation. By means of the displayed design ratio and coloured relation scales, you can see which 
cross-sections are little utilised and thus oversized, or overloaded and thus undersized. 

Optimise 
You can optimise every cross-section from the library: For the RSTAB internal forces, the pro-
gram searches the cross-section in the same table that comes as close as possible to a user-
defined maximum ratio. The maximum ratio can be defined in the dialog box Details, tab Other 
(see Figure 3.4, page 32). 

If you want to optimize a cross-section, open the drop-down list in column D or E and select 
the desired entry: From Current Row or, if available, From favorites 'Description'. Recommenda-
tions for the cross-section optimization can be found in chapter 7.2 on page 54. 

Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 
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A warning might appear before the calculation: Incorrect type of cross-section! This means that 
there is a cross-section that is not registered in the data base. This may be a user-defined cross-
section, or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropri-
ate cross-section for design, click [Library] (see description below Figure 2.8). 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, the 
module displays both cross-section numbers in two tables, in accordance with the definition in 
RSTAB. 

STEEL AS also designs tapered members, provided that the cross-section at the member's start 
has the same number of stress points as the cross-section at the member end. The normal 
stresses, for example, are determined from the moments of inertia and the centroidal distanc-
es of the stress points. If the start and the end cross-section of a tapered member have not the 
same number of stress points, the intermediate values cannot be interpolated. The calculation 
is neither possible in RSTAB nor in STEEL AS. 

The cross-section's stress points including numbering can also be checked graphically: Select 
the cross-section in table 1.3 and click [Info]. The dialog box shown in Figure 2.10 appears. 

Info About Cross-Section 
In the dialog box Info About Cross-Section, you can view the cross-section properties, stress 
points, and c/t-parts. 

 
Figure 2.10: Dialog box Info About Cross-Section 

In the right part of the dialog box, the currently selected cross-section is displayed. 

In STEEL AS, the indices of the member axes are different from those used in the code: The lon-
gitudinal axis is denoted by the index is x instead of z. For the axes in the cross-section plane, 
the axes y and z are used (see Figure 2.10). 
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The buttons below the graphic are reserved for the following functions: 

 

 

Table 2.2: Buttons of cross-section graphic 

Click [Details] to call up detailed information on stress points (distance to centre of gravity, 
statical moments of area, normalised warping constants etc.) and c/t-parts. 

 
Figure 2.11: Dialog box Stress Points of HE B 260 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbering of stress points or c/t-parts 

 
Displays or hides the details of the stress points or c/t-parts (see Figure 2.11) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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2.4 Lateral Intermediate Supports 

In table 1.4, you can define lateral intermediate supports for members. STEEL AS always as-
sumes this kind of support to be perpendicular to the cross-section's minor axis z (see Figure 
2.10). Thus, it is possible to influence the members' effective lengths which are important for 
the stability analyses concerning flexural buckling and lateral-torsional buckling. 

For the calculation, all lateral intermediate supports are considered as forked supports. 

 
Figure 2.12: Table 1.4 Lateral Intermediate Supports 

In the upper part of the table, you can assign up to nine lateral supports for each member. The 
lower table part shows you a summary of the data entered for the member selected above. 

If the check box Relatively (0 … 1) is selected, the support points can be defined by relative-
input. The positions of the intermediate supports are determined from the member length 
and the relative distances from the member start. When the check box Relatively (0 ... 1) is 
cleared, you can define the distances manually in the upper table. 

In case of cantilevers, avoid intermediate supports, as such supports divide the member in 
segments. Thus for cantilevered beams, this would results in segments that are forked sup-
ported on one side and thus statically underdetermined (forked support respectively on one 
end only). 
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2.5 Effective Lengths - Members 
The table is subdivided into two parts. The table in the upper part contains summarised infor-
mation about the factors for the lengths of buckling and lateral-torsional buckling as well as 
the equivalent member lengths of the members to be designed. The effective lengths defined 
in RSTAB are already preset. In the section Settings, further information is shown about the 
member whose row is selected in the upper section. 

Click the button [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 

 
Figure 2.13: Table 1.5 Effective Lengths - Members 

The effective lengths for local buckling about the minor axis are aligned automatically with the 
entries of table 1.4 Lateral Intermediate Supports. If lateral intermediate supports are dividing 
the member into member segments of different lengths, the program displays no value in the 
table columns G, I, and J of table 1.5. 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically by clicking the button [...] in the work window. This button is enabled when you 
click in the input field (see figure above). 

The Settings tree manages the following parameters: 

• Cross-Section 

• Member Length 

• Buckling Possible for member (cf columns B and E) 

• Buckling about Axis y Possible (cf columns C and D) 

• Buckling about Axis z Possible (cf columns F and G) 

• Lateral-Torsional Buckling Possible (cf columns I - L) 

• Member Type y-y 

• Member Type z-z 
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In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to that, you can adjust the Buckling Length 
Coefficient and the Warping Length Coefficient for the respective lengths. When a coefficient is 
modified, the equivalent member length will be adjusted automatically, and vice versa.  

The buckling length of a member can also be defined in a dialog box that can be accessed by 
clicking the button shown on the left. The button is located below the table. 

 
Figure 2.14: Dialog box Select Buckling Length Coefficient 

For every direction, the buckling length can be defined according to one of the four Euler 
buckling modes or User-defined. If a RSBUCK case calculated according to the eigenvalue anal-
ysis is already available, you can also define a Buckling Shape to determine the factor. 

Buckling Possible 
A stability analysis for flexural buckling requires the ability of members to absorb compressive 
forces. Therefore, members for which such absorption is not possible because of the member 
type (for example tension members, elastic foundations, rigid connections) are excluded from 
design in the first place. The corresponding rows appear dimmed and a note is indicated in the 
Comment column. 

The check boxes Buckling Possible in table row A and in the Settings tree offer you a control op-
tion for the stability analyses: They determine whether the analysis should or should not be 
performed for a member. 

Buckling about Axis y or Axis z 
With the check boxes in the Possible table columns, you decide whether a member has a risk of 
buckling about the axis y and/or z. These axes represent the local member axes, with axis y be-
ing the major and axis z the minor member axis. The buckling length coefficients Ky and K,z for 
buckling about the major or the minor axis can be selected freely. 

The position of the member axes can be checked in the cross-section graphic in table 1.3 
Cross-Sections (see Figure 2.8, page 14). 
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The indices of the member axes are different from those used in the Australian Standard: The 
longitudinal axis is denoted by the index is x instead of z. For the axes in the cross-section 
plane, the axes y and z are used. 

To access the RSTAB work window, click [View mode]. To show the local member axes in the 
RSTAB work window, you can use the member's context menu or the Display navigator. 

 
Figure 2.15: Selecting the member axis systems in the Display navigator of RSTAB 

If buckling is possible about one or even both member axes, you can enter the buckling length 
coefficients as well as the buckling lengths in the columns C and D or F and G. The same is pos-
sible in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a KL input field (see Figure 2.13). 

If you specify the buckling length coefficient K, the program determines the effective length KL 
by multiplying the member length L by the buckling length coefficient K. The input fields K 
and KL are interactive.  

Lateral-torsional Buckling Possible 
Table column H shows you for which members the program performs an analysis of lateral-
torsional buckling. 

With the check box in the Possible table columns, you decide whether a member has a risk of 
torsional-flexural and lateral-torsional buckling. When you have set the check, you can edit the 
buckling lengths  LW and LT in columns I and J. 

Moment Modification Factor αm 

The moment modification factor αm can be calculated according to the options given in clause 
5.6.1.1 of the standard. It is also possible to define this factor Manually. 

Lateral Rotation Restraint Factor Kr 

The lateral rotation restraint factor depending on the arrangement of the restraint is given in 
Table 5.6.3 (3) of the standard. 

Member Type 
Columns M and N define the restraint type of member segment according to clauses 5.6.1 and 
5.6.2 of the standard: Beam or Cantilever. The member type is equal for all member segments. 

Comment 
In the last table column, you can enter user-defined comments for each member to describe, 
for example, the selected equivalent member lengths. 
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Below the Settings table you find the check box Set inputs for members No. If selected, the set-
tings entered afterwards will be applied to the selected or even to All members. Members can 
be selected by typing the member number or by selecting them graphically using the [] but-
ton. This option is useful when you want to assign the same boundary conditions to several 
members. Please note that settings that have been already defined cannot be changed subse-
quently with this function. 

2.6 Effective Lengths - Sets of Members 
This table appears only if at least one Set of Members has been selected for design in the table 
1.1 General Data. 

 
Figure 2.16: Table 1.6 Effective Lengths - Sets of Members 

This table's concept is similar to the one in the previous table 1.5 Effective Lengths - Members.  
In this table, you can enter the effective lengths for the buckling about the two principal axes 
of the set of members as described in chapter 2.5. 
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2.7 Nodal Supports - Sets of Members 
This table is displayed when you have chosen at least one set of members for the design in ta-
ble 1.1 General Data. Table 1.7 is not available if in the dialog box Details, tab Stability (see Fig-
ure 3.2, page 29) the Member-like input has been selected for sets of members. In this case, you 
can define the lateral intermediate supports by division points in table 1.4. 

 
Figure 2.17: Table 1.7 Nodal Supports - Set of Members 

To determine the critical factor for lateral-torsional buckling, a planar framework is created 
with four degrees of freedom for each node which you have to define in table 1.7. This table 
refers to the current set of members (selected in the add-on module's navigator on the left). 

The orientation of axes in the set of members is important for the definition of nodal supports. 
The program checks the position of the nodes and internally defines, according to Figure 2.18 
to Figure 2.21, the axes of the nodal supports for table 1.7. 

 

Figure 2.18: Auxiliary coordinate system for nodal supports - straight set of members 

If all members of a set of members are lying in a straight line as shown in Figure 2.18, the local 
coordinate system of the first member in the set of members corresponds to the equivalent 
coordinate system of the entire set of members. 
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Figure 2.19: Auxiliary coordinate system for nodal supports - set of members in vertical plane 

If members of a set of members are not lying in a straight line, they must at least lie in the 
same plane. In Figure 2.19, they are lying in a vertical plane. In this case, the axis X' is horizontal 
and aligned in direction of the plane. The axis Y' is horizontal as well and defined perpendicu-
lar to the axis X'. The axis Z' is directed perpendicularly downwards. 

 

Figure 2.20: Auxiliary coordinate system for nodal supports - set of members in horizontal plane 

If the members of a buckled set of members are lying in a horizontal plane, the axis X' is de-
fined parallel to the X-axis of the global coordinate system. Thus, the axis Y' is set in opposite 
direction to the global Z-axis and the axis Z' is directed parallel to the global Y-axis. 

 

Figure 2.21: Auxiliary coordinate system for nodal supports - set of members in inclined plane 

Figure 2.21 shows the general case of a buckled set of members: The members are not lying in 
one straight line but in an inclined plane. The definition of the axis X' arises out of the intersec-
tion line of the inclined plane with the horizontal plane. Thus, the axis Y' is defined right-angled 
to the axis X' and directed perpendicular to the inclined plane. The axis Z' is defined perpendic-
ular to the axis X' and Y'. 
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2.8 Member End Releases - Sets of Members 
This table is displayed only if you have selected at least one set of members for the design in 
table 1.1 General Data. Here, you can define releases for members and sets of members that, 
due to structural reasons, do not pass the locked degrees of freedom specified in table 1.7 as 
internal forces. This table refers to the current set of members (selected in the add-on mod-
ule's navigator on the left). 

Table 1.8 is not available if in the dialog box Details, tab Stability (see Figure 3.2, page 29) the 
Member-like input has been selected for the sets of members. 

 
Table 2.22: Table 1.8 Member Releases - Set of Members 

In table column B, you define the Member Side to which the release should be assigned. You 
can also connect the releases to both member sides. 

In the columns C to F, you can define releases or spring constants to align the set of members 
model with the support conditions in table 1.7. 
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2.9 Serviceability Data 

This input table controls several settings for the serviceability limit state design. It is only avail-
able if you have set relevant entries in the Serviceability Limit State tab of table 1.1 (see chapter 
2.1.2, page 11). 

 
Table 2.23: Table 1.9 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RSTAB work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Table column E defines the governing Direction for the deformation analysis. You can select 
the directions of the local member axes y and z (or u and v for unsymmetrical cross-sections). 

A precamber wc can be taken into account by using entries specified in column F. 

The Beam Type is of vital importance for the correct application of limit deformations. In table 
column G, you can select the girder to be a beam or a cantilever and decide which end should 
have no support. 

The settings shown in the dialog box Details, tab Serviceability determine whether the defor-
mations are related to the undeformed initial structure or to the shifted ends of members or 
sets of members (see Figure 3.3, page 31). 
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3.  Calculation 
 

3.1 Detail Settings 
Before you start the calculation by clicking [Calculation], it is recommended to check the de-
sign details. The corresponding dialog box can be accessed in all tables of the add-on module 
by clicking [Details]. 

The dialog box Details contains the following tabs: 

• Ultimate Limit State 

• Stability 

• Serviceability 

• Other 

3.1.1 Ultimate Limit State 

 
Figure 3.1: Dialog box Details, tab Ultimate Limit State 

Options 
The Plastic design according to clause 4.5 can be used I-shape sections. When the conditions 
described in clause 4.5 are satisfied, hot-formed doubly symmetric I-sections can also be de-
signed according to clause 8.4.3. 
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Generally, cross-sections of the type “compact” are designed plastically. If you do not want to 
perform a plastic design, you can activate the Elastic design for compact cross-sections. 

The conservative general Elastic design is based on a stress analysis in stress points and the  
VON MISES equivalent stresses. It can be useful for cross-section that have complicated shapes, 
for members with torsional moments etc. 

The Shear design of solid flat or round bars or Shear buckling design of webs is not required in 
special cases. Those design options can be deactivated, if appropriate. 

By default, the shear and bending interaction method is set according to clause 5.12.3. It is 
possible to set the proportioning method according to clause 5.12.2 for cross-sections where 
bending is assumed to be resisted only by the flanges. 

The Australian standard offers alternative formulae for the compression and bending interac-
tion design of doubly symmetric I-sections and rectangular hollow sections. They can be used 
to determine the cross-section capacity (clause 8.3) and member capacity (clause 8.4). 

The conservative general elastic design based on shear stress analysis in stress points can be 
activated, if appropriate. 

Limit Internal Forces for Interaction 
The Australian standard gives no exact procedure how the design of torsional moments is to 
be handled. Therefore, STEEL AS includes an option to ignore shear stresses due to torsion, 
which makes it possible to design those cross-sections. The ratio of stress and shear strength 
can be defined manually. 

Cross-section Manufacture 
According to the Commentary on the Australian standard [2] , residual stresses should be tak-
en into account for the determination of element slenderness limits and cross-section types. In 
this dialog section, the type of manufacture can be specified that is to be applied for general 
and SHAPE-THIN cross-sections. 
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3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

Stability Analysis 
The check box Use controls whether to perform, in addition to the cross-section designs, a sta-
bility analysis. If you clear the check box, the input tables 1.4 to 1.8 will not be displayed. 

Second Order Effects 
You can Include the effects from second order theory according to clauses 4.4 and 4.5. When you 
design, for example, a frame whose governing buckling mode is represented by lateral dis-
placement, you can determine the internal forces according to linear static analysis and in-
crease them with the appropriate factors. If you increase the bending moment, this does not 
affect the flexural-buckling analysis according to [1], which is performed by using the axial 
forces. 

The Determination of factor βm can be conservative according to clause 4.4.2.2 a) or approxi-
mate according to clause 4.4.2.2 b) by matching the distribution of the bending moment along 
the member according to figure 4.4.2.2 in the Australian standard. The moment distributions 
can be displayed via the [Info] button. 

Structure Type 
According to clause 4.4.2, the type of member is required for determination of moment ampli-
fication factor. The check boxes of this dialog section define whether there are Sway or braced 
members in the model. 

Additionally, the Elastic buckling factor λc of whole frame (model) according to clause 4.7.2 can 
be specified. 
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Lateral-torsional Buckling 
If transverse loads exist, it is important to define where those forces are acting on the cross-
section: Depending on the Load Application point, transverse loads can be stabilizing or desta-
bilizing, and in this way they can critically influence the ideal critical moment. These settings 
have an effect on the determination of the load height factor Kl (see [1] table 5.6.3(2)). 

Set of Members - Member-Like Input 
The input of stability data of sets of members can be realised as member-like (table 1.6) or as 
general (tables 1.7 and 1.8). It is recommended to apply the STEEL AS design only for straight 
sets of members. If the default Do not use member-like input is set, the support conditions have 
to be defined in table 1.7 for all sets of members. The factors Kr of table 1.6 will not be used. 

The option Use for all sets of members makes it possible to define all stability data for sets of 
members in table 1.6 – analogically to table 1.5 for single members. In this case, tables 1.7 and 
1.8 are not displayed. The factors Kr and member types y-y and z-z as defined in table 1.6 are 
used to determine the support conditions β, uy, φx, φz, and ω. 

It is possible to Use only for Straight Sets of Members the member-like input. Additionally, equal 
cross-section parameters must apply. The factors Kr as defined in table 1.6 are applied; tables 
1.7 and 1.8 are not be displayed for straight sets. This option can be used e.g. for continuous 
beams. Please note that the factor Kr is identical for every segment or partial member of the 
set. 

The last option Use only to straight sets of members without intermediate restraints applies the 
member-like input only to sets of members which have supports or restraints at their ends that 
have been defined in RSTAB. Thus, it is possible to design e.g. simple beams or cantilevers. The 
connection of transverse beams to the intermediate nodes of the set is not accounted for, 
however. Tables 1.7 and 1.8 are not displayed for straight sets that have no intermediate sup-
ports. 

Welded I and H Sections Fabrications Acc. to 6.3.3 
For the fabrication of welded I and H sections, rolled or flame-cut plates can be used. The 
member section constant αb depends on the fabrication of the plates. It is given in table 6.3.3 
of the Australian standard. The type of fabrication which is set in this dialog box applies to all 
cross-sections of the design case. 

Limit Load for Special Cases 
To design unsymmetrical cross-sections for intended axial compression according to [1] 6.3, it 
is possible to neglect small moments about the major and the minor axis by settings defined in 
this dialog section. 

In the same way, you can switch off small compression forces for the pure design of bending by 
defining a limit ratio for N* to ФNs,pl. 

Intended torsion is not clearly specified in AS 4100. If a torsional stress is available that is not 
exceeding the shear stress ratio of 5 % preset by default, it is not considered in the stability de-
sign. In this case, the output shows results for flexural buckling and lateral-torsional buckling.  

If one of the limits in this dialog section is exceeded, a note appears in the results table. No 
stability analysis is carried out. Nevertheless, the cross-section designs are performed. These 
limit settings are not part of the Australian standard. Changing the limits is in the responsibility 
of the program user. 
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3.1.3 Serviceability 

 
Figure 3.3: Dialog box Details, tab Serviceability 

Deformation Related to 
The option fields control whether the maximum deformations are related to the shifted ends 
of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations have to be 
checked relative to the displacements in the entire structural system. 

Serviceability Limits (Deflections) Annex B 
In this dialog section, the limit deformations can be checked and, if necessary, adjusted. 
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3.1.4 Other 

 
Figure 3.4: Dialog box Details, tab Other 

Cross-Section Optimisation 
The optimisation is targeted on the maximum stress ratio of 100 %. If necessary, you can speci-
fy a different limit value in this input field. 

Check of Member Slendernesses 
The two fields allow for the input of limit values λlimit in order to define member slendernesses. 
It is possible to enter specifications separately for members with pure tension forces and 
members with bending and compression. 

In table 3.3, the limit values are compared to the real member slendernesses. This table is 
available only after the calculation (see chapter 4.8, page 40 ) and if the corresponding check 
box is selected in the dialog section Display Result Tables. 

Display Result Tables 
In this dialog section, you can select the results tables including parts list that you want to be 
displayed. The tables are described in chapter 4 Results. 

The table 3.3 Member Slendernesses is inactive by default. 
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3.2 Start Calculation 
To start the calculation, click the [Calculation] button that is available in all input tables of the 
STEEL AS add-on module. 

STEEL AS searches for the results of the load cases, load combinations, and result combinations 
to be designed. If these cannot be found, the program starts the RSTAB calculation to deter-
mine the design relevant internal forces. 

You can also start the calculation in the RSTAB user interface: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules like load cases and load 
combinations are listed. 

 
Figure 3.5: Dialog box To Calculate 

If the STEEL AS design cases are missing in the Not Calculated list, select All or Add-on Modules 
in the drop-down list at the end of the list. 

To transfer the selected STEEL AS cases to the list on the right, use the button []. Click [OK] to 
start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the STEEL AS design case in 
the toolbar list, and then click [Show Results]. 

 
Figure 3.6: Direct calculation of a STEEL AS design case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 



4  Results 

 

 

34 Program STEEL AS © 2013 Dlubal Engineering Software 

    

4.  Results 
Table 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results table with designs and intermediate values 

The designs are shown in the results tables 2.1 to 2.5, sorted by different criteria. 

The tables 3.1 and 3.2 list the governing internal forces. Table 3.3 informs you about the mem-
ber slendernesses. In the last two results tables, 4.1 and 4.2, parts lists are displayed by mem-
ber and set of members. 

Every table can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input table, use the buttons shown on the left. You can also use the function 
keys to select the next [F2] or previous [F3] table. 

Click [OK] to save the results. Thus you exit STEEL AS and return to the main program. 

Chapter 4 Results describes the different results tables one by one. Evaluating and checking 
the results is described in chapter 5 Results Evaluation, page 44 ff. 
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4.1 Design by Load Case 
The upper part of this table offers a summery, sorted by load cases, load and result combina-
tions of the governing designs. Furthermore, the list contains ultimate limit state, serviceability 
and stability design. 

The lower part contains detailed information about the cross-section characteristics, analysed 
internal forces, and design parameters for the load case selected above. 

 
Figure 4.2: Table 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the design. 

Member No. 
This column shows the number of the member that bears the maximum stress ratio of the  
designed loading. 

Location x 
This column shows the respective x-location where the member's maximum stress ratio  
occurs. For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters) 

• Extreme values of internal forces 

Design 
Columns D and E display the design conditions according to AS 4100-1998. 

The length of the coloured scale represents the respective stress ratio. 



4  Results 

 

 

36 Program STEEL AS © 2013 Dlubal Engineering Software 

Design according to Formula 
This column lists the code's equations by which the designs have been performed. 

DS 
The final column contains information about the respective design-relevant design situation 
(DS): ULS (ultimate limit state) or one of the two design situations for serviceability (Short Term 
Effects, Long Term Effects) according to the specification in table 1.1 General Data (see Figure 
2.4, page 11). 

4.2 Design by Cross-Section 

 
Figure 4.3: Table 2.2 Design by Cross-Section 

This table lists the maximum ratios of all members and actions selected for design, sorted by 
cross-section. The results are sorted by cross-section design, stability analysis and serviceability 
limit state design. 

If you have a tapered member, both cross-section descriptions are displayed in the table row 
next to the section number. 
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4.3 Design by Set of Members 

 
Figure 4.4: Table 2.3 Design by Set of Members 

This results table is displayed if you have selected at least one set of members for design. The 
table lists the maximum ratios sorted by set of members. 

The Column Member No. shows the number of the one member within the set of members 
that bears the maximum ratio for the individual design criteria. 

The output by set of members clearly presents the design for an entire structural group (for 
example a frame). 
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4.4 Design by Member 

 
Figure 4.5: Table 2.4 Design by Member 

This results table presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in chapter 4.1 on page 35. 

4.5 Design by x-Location 

 
Figure 4.6: Table 2.5 Design by x-Location 
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This results table lists the maxima for each member at the locations x resulting from the divi-
sion points defined in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Register Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Table 3.1 Governing Internal Forces by Member 

This table displays for each member the governing internal forces that result in maximum 
stress ratios in each design. 

Location x 
At this x location of the member, the respective maximum stress ratio occurs. 

Load Case 
This column displays the number of the load case, the load or result combination whose inter-
nal forces produce maximum stresses. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum stresses in the respective cross-section designs, stabil-
ity analyses and serviceability limit state designs. 

Design According to Formula 
The final column informs you about the design types and the equations by which the designs 
according to [1] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Table 3.2 Governing Internal Forces by Set of Members 

This table contains the internal forces that result in the maximum ratios within the design of 
each set of members. 

4.8 Member Slendernesses 

 
Figure 4.9: Table 3.3 Member Slendernesses 
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This results table is shown only if you select the respective check box in the dialog box Details, 
tab Other (see Figure 3.4, page 32). 

The table lists the effective slendernesses of the designed members for both directions of the 
principal axes. They were determined depending on the type of load. At the end of the list, you 
find a comparison with the limit values that have been defined in the Details dialog box, tab 
Other (see Figure 3.4, page 32). 

Members of the member type "Tension" or "Cable" are not included in this table. 

This table is displayed only for information. No stability design of slendernesses is intended. 

4.9 Parts List by Member 
Finally, STEEL AS Cross-sections provides a summary of all members that are included in the 
design case. 

 
Figure 4.10: Table 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 
3.4, page 32). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 
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Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area related to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in tables 1.3 
and 2.1 to 2.5 in the cross-section information (see Figure 2.10, page 16). 

Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Cross-Section Mass 
The Cross-Section Mass is related to the length of one meter. For tapered cross-sections, the 
program averages both cross-section properties. 

Mass 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Mass 
The final column indicates the total mass of each part. 

Sum 
At the bottom of the list, you find a summary of the summed up values of column B, D, E, F, 
and I. The last data field of the column Total Mass gives information about the total amount of 
steel required. 
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4.10 Parts List by Set of Members  

 
Figure 4.11: Table 4.2 Parts List by Set of Members 

The last results table is displayed if you have selected at least one set of members for design. 
The table summarises an entire structural group (for example a horizontal beam) in a parts list. 

Details on the various columns can be found in the previous chapter. If different cross-sections 
are used in the set of members, the program averages the surface area, the volume, and the 
cross-section mass. 
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5.  Results Evaluation 
You can evaluate the design results in various manners. The buttons below the first table part 
can be helpful for the evaluation process. 

 
Figure 5.1: Buttons for results evaluation 

The buttons are reserved for the following functions: 

Button Description Function 

 
Ultimate Limit State  
Designs 

Turns on and off the results of the ultimate limit 
state design 

 
Serviceability Limit State 
Designs 

Turns on and off the results of the serviceability 
limit state design 

 Show Colour Bars 
Turns on and off the coloured reference scales in  
the results tables 

 Show Rows with Ratio > 1 
Displays only the rows where the ratio is more  
than 1, and thus the design is failed 

 Result Diagrams 
Opens the window Result Diagram on Member 
 chapter 5.2, page 47 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 chapter 7.4.3, page 58 

 Member Selection 
Allows you to graphically select a member to  
display its results in the table 

 View Mode 
Jumps to the RSTAB work window to change the 
view 

Table 5.1: Buttons in results tables 2.1 to 2.5 
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5.1 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful for finding the position of a particular 
member in the model: The member selected in the STEEL AS results table is highlighted in the 
selection colour in the background graphic. Furthermore, an arrow indicates the member's  
x-location that is displayed in the selected table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

In case you cannot improve the display by moving the STEEL AS module window, click [Jump 
to Graphic] to activate the View Mode: The program hides the module window so that you can 
modify the display in the RSTAB user interface. The view mode provides the functions of the 
View menu, for example zooming, moving, or rotating the display. The pointer remains visible. 

Click [Back] to return to the add-on module STEEL AS. 

RSTAB work window 
The ratios can also be checked graphically in the RSTAB model. Click [Graphics] to exit the de-
sign module. The ratios are displayed in the RSTAB work window like internal forces of a load 
case. 

In the Results navigator of STEEL AS, you can choose which design ratios of the ULS or SLS 
analyses are to be displayed graphically. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RSTAB. To display the result values, use the toolbar button [Show 
Values] to the right. 

As the RSTAB tables are of no relevance for the evaluation of design results, you can hide them.  
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The design cases can be set by means of the list in the RSTAB menu bar. 

The graphical representation of the results can be controlled in the Display navigator by  
selecting Results → Members. The display of ratios is Two-Coloured by default. 

 

Figure 5.3: Display navigator: Results → Members 

In case of a multicolour representation (options With/Without Diagram or Cross-Sections), the 
colour panel is available, providing common control functions. The functions are described in 
detail in the RSTAB manual, chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

The graphics of the design results can be transferred to the printout report (see chapter 6.2, 
page 50) by clicking the panel button [STEEL AS].  
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5.2 Result Diagrams 
You can also evaluate a member's result distributions in the result diagram graphically. 

To do this, select the member (or set of members) in the STEEL AS results table by clicking in 
the table row of the member. Then open the dialog box Result Diagram on Member by clicking 
the button shown on the left. The button is at the bottom of the upper results table (see Figure 
5.1, page 44). 

The result diagrams are available in the RSTAB graphic. To display the diagrams, click 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant STEEL AS design case. 

The dialog box Result Diagram on Member is described in detail in the RSTAB manual, chapter 
9.5. 
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5.3 Filter for Results 
The STEEL AS results tables allow you to sort the results by various criteria. In addition, you can 
use the filter options described in chapter 9.7 of the RSTAB manual to evaluate the design re-
sults graphically. 

You can use the option Visibility also for STEEL AS (see RSTAB manual, chapter 9.7.1) to filter 
the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window, which can be 
accessed by clicking [Graphics]. To apply this filter function, the panel must be displayed. If the 
panel is not active, click 

View → Control Panel (Colour Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Colour spectrum). As this register is not available for the 
two-coloured results display, you have to use the Display navigator and set the display options 
Coloured With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted colour spectrum 

As the figure above shows, the colour spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a colour range between blue and red. 

If you select the option Display Hidden Result Diagram in the Display navigator (Results →  
Members), you can display all stress ratio diagrams that are not covered by the colour spectrum. 
Those diagrams will be represented by dotted lines.  
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in detail in the RSTAB 
manual, chapter 9.7.3. 

 

Figure 5.7: Member filter for the stress ratios of a hall frame 

Unlike the partial view function, the model is now displayed completely in the graphic. The 
figure above shows the design ratios of a hall frame. The remaining members are displayed in 
the model but are shown without design ratios. 
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6.  Printout 
 

6.1 Printout report 
Similar to RSTAB, the program generates a printout report for the STEEL AS results, to which 
graphics and descriptions can be added. In the printout report, you can select the data from 
the design module to be included in the printout. 

The printout report is described in the RSTAB manual. In particular, chapter 10.1.3.4 Selecting 
Data of Add-on Modules provides information concerning the selection of input and output da-
ta in add-on modules for the printout. 

For large structural systems with many design cases, it is recommended to split the data into 
several printout reports, thus allowing for a clearly-arranged printout. 

6.2 STEEL AS Graphic Printout 
In RSTAB, every picture that is displayed in the work window can be included in the printout 
report or send directly to a printer. Thus, the design ratios displayed in the RSTAB model can 
be prepared for the printout, too. 

The printing of graphics is described in the RSTAB manual, chapter 10.2. 

Designs in the RSTAB model 
To print the currently displayed graphic of the design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in RSTAB toolbar 

Result Diagrams 
You can also transfer the Result Diagram on Member to the report by using the [Print] button. It 
is also possible to print it directly. 

 
Figure 6.2: Button Print Graphic in the dialog box Result Diagram on Member 
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The following dialog box opens: 

 
Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, chapter 10.2. The RSTAB manual also de-
scribes the Options and Colour Spectrum tab. 

A graphic can be moved anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The option Properties in the context menu opens the dialog 
box Graphic Printout, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
The final chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyse members with particular design specifications (for exam-
ple changed materials, partial safety factors, optimisation). 

It is no problem to analyse the same member or set of members in different design cases. 

To calculate a STEEL AS design case, you can also use the load case list in the RSTAB toolbar. 

Create a New Design Case 
To create a new design case, use the STEEL AS menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL AS-Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the STEEL AS table 1.1 General Data where you can enter the design data. 

Rename a Design Case 
To change the description of a design case, use the STEEL AS menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL AS-Case 

In this dialog box, you can define a different Description as well as a different No. for the design 
case. 
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Copy a Design Case 
To copy the input data of the current design case, use the STEEL AS menu and click 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL AS-Case 

Define the No. and, if necessary, a Description for the new case. 

Delete a Design Case 
To delete design cases, use the STEEL AS menu and click 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Case 

The design case can be selected in the list Available Cases. To delete the selected case, click 
[OK]. 
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7.2 Cross-Section Optimisation 
The design module offers you the option to optimise overloaded or little utilised cross-
sections. To do this, select in column D of the relevant cross-sections in table 1.3 Cross-Sections 
whether to determine the cross-section From the current row or the user-defined Favorites (see 
Figure 2.8, page 14). You can also start the cross-section optimisation out of the results tables 
by using the context menu. 

 
Figure 7.5: Context menu for cross-section optimisation 

During the optimisation process, the module determines the cross-section within the same 
cross-section table that fulfils the analysis requirements in the most optimal way, that is, 
comes as close as possible to the maximum allowable stress ratio specified in the Details dialog 
box (see Figure 3.4, page 32). The required cross-section properties will be determined with 
the internal forces from RSTAB. If another cross-section proves to be more favourable, this 
cross-section will be used for the design. Then, the graphic in table 1.3 will show two cross-
sections: the original cross-section from RSTAB and the optimised one (see Figure 7.7). 

For a parameterised cross-section, the dialog box Optimise appears if you select the corre-
sponding option. 

 
Figure 7.6: Dialog box Welded Cross-Sections - I symmetric : Optimise 

By selecting the check boxes in the Optimise column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimisation process. 
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If you want to Keep current side proportions, select the corresponding check box. In addition, 
you have to select at least two parameters for optimisation. 

Cross-sections based on combined rolled cross-sections cannot be optimised. 

Please note for the optimisation process that the internal forces will not be recalculated auto-
matically with the changed cross-sections: It is up to you to decide which thicknesses or cross-
sections should be transferred to RSTAB for recalculation. As a result of optimised cross-
sections, the internal forces may vary significantly because of the changed stiffnesses in the 
structural system. Therefore, it is recommended to recalculate the internal forces of the modi-
fied cross-section data after the first optimisation, and then to optimise the cross-sections 
once again. 

The modified cross-sections can be exported to RSTAB: Set table 1.3 Cross-Sections, and then 
click 

Edit → Export All Cross-Sections to RSTAB. 

The context menu in table 1.3 provides options to export optimised cross-sections to RSTAB. 

 
Figure 7.7: Context menu in table 1.3 Cross-Sections 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted.  

 
Figure 7.8: Query before transfer of modified cross-sections to RSTAB 

By confirming the query and starting the [Calculation] subsequently in the STEEL AS module, 
the internal forces of RSTAB and the designs will be determined in one single calculation run. 
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If the modified cross-sections have not been exported to RSTAB yet, you can import the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in table 1.3 Cross-sections. 

If you optimise a tapered member, the program modifies the member start and end. Then it 
linearly interpolates the second moments of area for the intermediate locations. As these mo-
ments are considered with the fourth power, the designs may be inaccurate if the depths of 
the start and end cross-section differ considerably. In such a case, it is recommended to divide 
the taper into several members, thus manually modelling the taper layout. 

7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one dialog box. 
In STEEL AS, you can use the menu to define the units. To open the corresponding dialog box, 
click 

Settings → Units and Decimal Places. 

The program opens the following dialog box that you already know from RSTAB. STEEL AS will 
be preset in the list Program / Module. 

 
Figure 7.9: Dialog box Units and Decimal Places 

The settings can be saved as user profile to reuse them in other models. These functions are 
described in the RSTAB manual, chapter 11.1.3. 
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7.4 Data Transfer 
7.4.1 Material Export to RSTAB 
If you have adjusted the materials in STEEL AS for design, you can export the modified materi-
als to RSTAB in a similar manner as you export members and cross-sections: Open table 1.2 
Materials, and then click 

Edit → Export All Materials to RSTAB. 

The modified materials can also be exported to RSTAB by using the context menu of table 1.2. 

 
Figure 7.10: Context menu of table 1.2 Materials 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. After you confirm the query and start the [Calculation] 
subsequently in STEEL AS, the RSTAB internal forces and designs will be determined in one 
single calculation run. 

If the modified materials have not been exported to RSTAB yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.10. Please note, however, 
that this option is only available in table 1.2 Materials. 

7.4.2 Export Effective Lengths to RSTAB 
If you have adjusted the materials in STEEL AS for design, you can export the modified materi-
als to RSTAB in a similar manner as you export cross-sections: Open table 1.5 Effective Lengths - 
Members, and then click 

Edit → Export All Effective Lengths to RSTAB. 

The modified effective lengths can also be exported to RSTAB via the context menu of table 1.5. 

 
Figure 7.11: Context menu of table 1.5 Effective Lengths - Members 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. 

If the modified effective lengths have not been exported to RSTAB yet, you can retransfer the 
original effective lengths to the design module, using the options shown in Figure 7.11. Please 
note, however, that this option is only available in table 1.5 Effective Lengths - Members and 1.6 
Effective Lengths - Sets of Members. 

7.4.3 Export of Results 
The STEEL AS results can also be used by other programs. 

Clipboard 
To copy cells selected in the results tables to the Clipboard, press the keys [Ctrl]+[C]. To insert 
the cells, for example in a word-processing program, press [Ctrl]+[V]. The headers of the table 
columns will not be transferred. 
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Printout report 
The data of the STEEL AS add-on module can be printed into the global printout report (see 
chapter 6.1, page 50) for export. Then, in the printout report, click 

File → Export to RTF. 

The function is described in the RSTAB manual, 10.1.11. 

Excel / OpenOffice 
STEEL AS provides a function for the direct data export to MS Excel, OpenOffice.org Calc or the 
file format CSV. To open the corresponding dialog box, click 

File → Export Tables. 

The following export dialog box appears. 

 
Figure 7.12: Dialog box Export - MS Excel 

When you have selected the relevant parameters, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.13: Result in Excel 
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8.  Example 
 

In our example we perform the stability analyses of flexural buckling and lateral-torsional 
buckling for a column with double-bending, taking into account the interaction conditions. 

Design values 

System and Loads 

q z

2 
m

2 
m

4 
m

Fy

N

z

y

HEB160

 

Figure 8.1: System and design loads (γ-fold) 

Internal forces according to linear static analysis 

             
  N My Mz Vy Vz 

Figure 8.2: Internal forces 

Design values of the static loads 

Nd = 300 kN 

qz,d = 5.0 kN/m 

Fy,d = 7.5 kN 
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Design location (decisive x-location) 

The design is performed for all x-locations (see chapter 4.5) of the equivalent member.  
The decisive location is x = 2.00 m. RSTAB determines the following internal forces: 

N = –300.00 kN       My = 10.00 kNm       Mz = 7.50 kNm      Vy = 3.75 kN      Vz = 0.00 kN 

Cross-Section Properties HE-B 160, Steel 250 

 Property  Symbol Value Unit 

 Cross-section area  A 5425.00 mm2 

 Moment of inertia  Iy 24920000.00 mm4 

 Moment of inertia  Iz 8892000.00 mm4 

 Governing radius of gyration  ry 67.80 mm 

 Governing radius of gyration  rz 40.50 mm 

 Polar radius of gyration  ro 78.97 mm 

 Polar radius of gyration  ro,M 419.00 mm 

 Cross-section mass  M 42.63 kg/m 

 Torsional constant  J 312400.00 mm4 

 Warping constant  Cω 47940000000.00 mm6 

 Elastic section modulus  Zy 311500.00 mm3 

 Elastic section modulus  Zz 111200.00 mm3 

 Plastic section modulus  Sy 354000.00 mm3 

 Plastic section modulus  Sz 169960.00 mm3 

Flexural buckling about the minor axis (⊥ to z-z axis) 
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The appropriate section constant αb is given in Table 6.3.3(1). 

αb = 0.00 for hot-rolled I-section (tf ≤ 40 mm) 
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Result values from STEEL AS calculation 

 Manufacture  HR    

 Compression Axial Force  N* 300 kN   

 Nominal Section Capacity  Ns 1373.840 kN   

 Form Factor  kf 1.000    6.2.2 

 Yield Strength  fy 250 MPa   2.1 

 Modulus of Elasticity  E 200000 MPa   

 Gross Area  Ag 5425 mm2   

 Second Moment of Area  Iz 8892000 mm4   

 Radius of Gyration  rz 40.486 mm   

 Effective Length  le,z 4000 mm   

 Geometrical Slenderness  λg,z 98.801    6.3.1 

 Elastic Flexural Buckling Load  Nom,z 1097.010 kN   4.6.2 

 Auxiliary Factor  αa,z 17.392    6.3.3 

 Section Constant  αb 0    Tab. 6.3.3 

 Modified Slenderness  λn,z 98.801    6.3.3 

 Slenderness  λz 98.801    6.3.3 

 Auxiliary Factor  ηz 0.278    6.3.3 

 Auxiliary Factor  ξz 1.030    6.3.3 

 Reduction Factor  αc,z 0.549    6.3.3 

 Capacity Factor  Ф 0.900    Tab. 3.4 

 Nominal Member Capacity  Nc,z 754.172 kN   6.3 

 Design Ratio  η 0.442   ≤ 1  6.1 
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Flexural buckling about the major axis (⊥ to y-y axis) 
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The appropriate section constant αb is given in Table 6.3.3(1). 

αb = 0.00 for hot-rolled I-section (tf ≤ 40 mm) 
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Result values from STEEL AS calculation 

 Manufacture  HR    

 Compression Axial Force  N* 300 kN   

 Nominal Section Capacity  Ns 1373.840 kN   

 Form Factor  kf 1.000    6.2.2 

 Yield Strength  fy 250 MPa   2.1 

 Modulus of Elasticity  E 200000 MPa   

 Gross Area  Ag 5425 mm2   
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 Second Moment of Area  Iy 24920000 mm4   

 Radius of Gyration  ry 67.776 mm   

 Effective Length  le,y 4000 mm   

 Geometrical Slenderness  λg,y 59.018    6.3.1 

 Elastic Flexural Buckling Load  Nom,y 3074.380 kN   4.6.2 

 Auxiliary Factor  αa,y 20.645    6.3.3 

 Section Constant  αb 0    Table 6.3.3 

 Modified Slenderness  λy,z 59.018    6.3.3 

 Slenderness  λy 59.018    6.3.3 

 Auxiliary Factor  ηy 0.148    6.3.3 

 Auxiliary Factor  ξy 1.835    6.3.3 

 Reduction Factor  αc,y 0.814    6.3.3 

 Capacity Factor  Ф 0.900    Table 3.4 

 Nominal Member Capacity  Nc,y 1118.470 kN   6.3 

 Design Ratio  η 0.298   ≤ 1  6.1 

Lateral-torsional buckling 

Effective length 

Twist restraint factor kt = 1.0 

The point of load application is assumed to be in the shear centre. The application point for 
transverse loads can be adjusted in Details dialog box (see chapter 3.1.2, page 29). 

Load height factor kl = 1.0 

Lateral rotation factor kr = 1.0 

Effective length according to clause 5.6.3 

mm4000LkkkL rltw =⋅⋅⋅=  

Reference buckling moment 

The reference buckling moment for lateral torsional buckling will be determined for this ex-
ample according to Eq. 5.6.1.1(3), taking into account pinned supports free to warp. 
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Nominal member moment capacity 

The nominal member moment capacity of the segment without full lateral restraint, fully  
restrained at both ends of open cross-section with equal flanges constant along member is 
calculated according to Eq. 5.6.1.1(1). 

The moment modification factor can be determined according to clauses 5.6.1.1 (a) (i) to (iv). 
We can use data from table 5.6.1 for a parabolic moment diagram: αm = 1.13. 

The slenderness reduction factor is calculated according to Eq. 5.6.1.1(2). 

The nominal section moment capacity is determined in accordance with clause 5.2 for the 
gross cross-section: 

HEB-160, cross-section type “compact”: ³mm354000Sy =  

kNm5.88)3115005.1;354000min(250)Z5.1;Smin(fM yyyy,s =⋅⋅=⋅⋅=
 STEEL AS calculates value of Ms,y, taking into account different yield strengths of the material 

depending on the material thickness. Therefore, we can use:
 

kNm86.88M y,s =
 

Now we can calculate the slenderness reduction factor: 
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Finally, we determine the nominal member moment capacity: 

kNm251.7986.88789.013.1MM y,ssmy,b =⋅⋅=⋅α⋅α=
 

Interaction of biaxial bending and compression 

The design ratio is determined according to clause 8.4.5.1. 

Calculation of Mi,y Mi,z and Mo,y 

Nominal in-plane member moment capacity Mi,y acc. to clause 8.4.2.2 
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We can use the alternative calculation for doubly symmetric compact I-sections with kf = 1.0: 
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In this equation, we use the equivalent moment factor βm,y = -1.0 according to clause 4.4.2.2(a).
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kNm381.62M y,i =  
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Nominal in-plane member moment capacity Mi,z acc. to clause 8.4.2.2 

kNm70.41)1112005.1;170000min(250)Z5.1;Smin(fM zzyz,s =⋅⋅=⋅⋅=  
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We can use the alternative calculation for doubly symmetric compact I-sections with kf = 1.0: 
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In this equation, we use the equivalent moment factor βm,z = -1.0 according to clause 4.4.2.2(a).
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kNm277.23M z,i =  

Nominal out-of-plane member moment capacity Mo,y acc. to clause 8.4.4.1 
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Interaction design ratio acc. to clause 8.4.5.1 

For Mc,y, the lesser value of the nominal in-plane member capacity Mi,y and the nominal out-of-
plane capacity Mo,y has to be applied. In our example, Mo,y is relevant. 
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Result values from STEEL AS calculation 

 Beam Type  Beam    

 Beam Type  BTz Beam    

 Compression Axial Force  N* 300.000 kN   

 Nominal Member Capacity  Nc 754.172 kN   6.3 

 Bending Moment  M*y 10.000 kNm   

 Maximum Bending Moment  M*y,segm 10.000 kNm   

 Modulus of Elasticity  E 200000 MPa   

 Shear Modulus  G 80000 MPa   

 Second Moment of Area  Iz 8892000 mm4   

 Torsional Constant  J 312400.000 mm4   

 Warping Constant  Iw 4.79400E+10 mm6   

 Segment Length  l 4000 mm   

 Twist Restraint Factor  kt 1.000    Table 5.6.3(1) 

 Load Height Factor  kl 1.000    Table 5.6.3(2) 

 Lateral Rotation Restraint Factor  kr 1.000    Table 5.6.3(3) 

 Effective Length  le                                                                         4000 mm   5.6.2 

 Section Constant  β 0.000    5.6.1.2 or H.4 

 Modification Factor  αm 1.130    5.6 

 Slenderness Reduction Factor  αs 0.789    5.6 

 Amended Elastic Buckling Moment  Moa 184.132 kNm   

 Nominal Out-of-plane Capacity  Mby 79.268 kNm   5.6 

 Equivalent Moment Factor  βmy -1.000    8.4.2.2 

 Nominal Section Capacity  Msy 88.859 kNm   5.2 

 Nominal Section Capacity  Mry 67.299 kNm   8.3 

 Nominal In-plane Capacity  Miy 62.377 kNm   8.4 

 Nominal Out-of-plane Capacity  Moy 44.233 kNm   8.4.2 

 Nominal Moment Capacity  My 44.233 kNm   8.4 

 Design Component for My  ηMy 0.251    

 Bending Moment  M*z 7.500 kNm   

 Equivalent Moment Factor  βmz -1.000    8.4.2.2 

 Nominal Section Capacity  Msz 41.700 kNm   5.2 

 Nominal Section Capacity  Mrz 31.582 kNm   8.3 

 Nominal In-plane Capacity  Miz 23.269 kNm   8.4 

 Design Component for Mz  ηMz 0.358    

 Capacity Factor  Ф 0.900    

 Design Ratio  η 0.382   ≤ 1  8.4.5.1 
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